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PREFACE

Welcome to the Oracle Insurance Insbridge Enterprise Rating Installation Guide. The Insbridge
Enterprise Rating (Insbridge) System is a browser-based, multiplatform insurance rating and
underwriting technology solution that provides integrated management for every aspect of the
rate definition and modification process. This guide assists with the installation of the Insbridge
Enterprise Rating System.

AUDIENCE

This guide is intended for system administrators, installers, database administrators and others
tasked with installing and configuring the Insbridge system and associated databases.

PLANNING YOUR INSBRIDGE SYSTEM

Prior to installation, you should have an idea of the type of setup you want to create. What kind of
equipment do you have available and how many environments do you need? If you do not have
everything completely planned out, you can still proceed. Environments can be removed or added
later on. The Oracle Insurance Insbridge Enterprise Rating system (Insbridge) is expandable and
can accommodate a few different configurations.

For more on planning your Insbridge system, please see the Insbridge Implementation Guide.

TYPES OF INSTALLATION

There are various types of installations:

RateManager Installation

o RateManager for Windows — Installs RateManager and the Insbridge Framework
Administrator (IBFA) in a Windows environment and utilizes IBFA for local rating. This
Windows only environment uses a SQL Server database.

SoftRater Installation

o SoftRater for Java Installation — Deploys Insbridge SoftRater Server (IBSS) to an
application server; WebLogic, WebSphere or JBoss, using a SQL Server database, or an
Oracle database, or a DB2 database.
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o SoftRater for Windows Node — This installation is for existing environments that want to
add a SoftRater for Windows node to an environment. This is for a Windows only
environment using a SQL Server database.

Upgrading a Current Installation

o Upgrade — Upgrades existing customers from their current version of Insbridge up to
version 04.09.00.

This guide is for a RateManager installation.

Definitions

Some commonly used terms when installing or using the Oracle Insurance Insbridge Enterprise
Rating system:

o IBER: Insbridge Enterprise Rating System. Most often referred to as Insbridge. This is
the entire system.

e IBFA: Insbridge Framework Administrator. IBFA is an administrative tool used to
configure Insbridge applications and setup RateManager database connections. IBFA will
be located on a Windows Server machine. IBFA/SR-WIN is an Insbridge Framework
Administrator/SoftRater for Windows.

e IBSS: Insbridge SoftRater Server. IBSS is the administrative tool for the SoftRater
engine. The SoftRater engine is a multi-platform component within Insbridge that
executes the rules, rating and underwriting instructions as defined by the user in
RateManager. IBSS is usually located on a Java machine. IBSS/SR-JAVA is an Insbridge
SoftRater Server/SoftRater for Java.

o SoftRater Node: A SoftRater node is either an IBFA (without RateManager) or IBSS
instance on a physical environment.

o SoftRater Native: SoftRater Native is a remote instance of SoftRater that can execute
rules and rating logic in environments where access via the SoftRater web-services is not
desired or possible.

¢ RM: RateManager. RateManager is a component within Insbridge that enables users to
manage the product definition and modification process, including rating and underwriting
logic.

¢ SR: SoftRater. The engine that executes the rating, rules and underwriting instructions
defined within RateManager. The rating environment for runtime execution and
processing of business content. SoftRater can be further defined by the operating system
where it has been loaded.

e SR-WIN: SoftRater for Windows. This is also another name for IBFA.

e SR-JAVA: SoftRater for Java. This is also another name for IBSS.
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e SRP: SoftRater Packages. A package that holds all the RateManager logic for a specific
program and version.

o VFS: Virtual File Servers. Virtual file server management allows you to access
environments that are located on other machines in different locations where packages
can be downloaded.

o Package Location: A pointer to a location where SoftRater Packages (SRP’s) are
stored.

e Physical Environment: A physical environment is generally referred to as a physical
machine.

o Authoring Environment: The physical machine where RateManager is installed.

o Rating Environment: The physical machine(s) where SoftRater is installed. This is
typically the same as a SoftRater node.

o Logical Environment: An environment created for a subscriber in IBFA. It defines
package location, engine location and database location in addition to several other

supporting data items. This environment is used for rating and/or SRP management.
Each database connection will have a logical environment.

RELATED DOCUMENTS

For more information, refer to the following Oracle resources:

e The Oracle Insurance Insbridge Enterprise Rating Operating Environments for Hardware
and Software.

e You can view this guide on-line at this address:

http://www.oracle.com/technetwork/documentation/insurance-097481.html

CONVENTIONS

The following text conventions are used in this document:

Convention  Description

Boldface type indicates graphical user interface elements associated

bel with an action.

ltalic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

Monospace Monospace type indicates commands within a paragraph, URLS, code

in examples, text that appears on the screen, or text that you enter.
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Manual History

New editions incorporate any updates issued since the previous edition.

Edition PUEl eI Prod_uct Publication Date Comment
| Number Version

1* Edition P01-701-15 R 4.0 April 2010 Update for 32 bit
2" Edition P01-701-16 R 4.0.1 August 2010 Update Release
3" Edition P01-701-17 R 4.1 December 2010 Update

4" Editon  P01-701-18 R 4.5 May 2011 Update

5" Editon ~ P01-701-19 R 4.5.1 September 2011 Update

6" Editon  P01-701-20 R 4.6 May 2012 Update

7" Edition ~ P01-701-21 R 4.6.1 November 2012  Update Release
8" Edition P01-701-22 R 4.7 September 2013  Update Release
9" Edition P01-701-23 R4.7.1 November 2013 Update Release
10" Editon P01-701-24 R 4.8 August 2014 Update Release
11" Editon P01-701-25 R 4.9 December 2014  Update Release

Oracle Insurance Insbridge Enterprise Rating Installation Guide Page 10



Chapter 1

SYSTEM REQUIREMENTS

Insbridge installers should be familiar with managing a Windows server. The Insbridge installation is for a
64-bit system. 32-bit systems are no longer supported.

Required Components

The following components, web server roles, and features are required:
e A full installation of Microsoft Windows Server 2008

e Microsoft .NET Framework version 4.5 with .NET 3.5.1 feature activation
o |IS: Internet Information Services version 6.0 or 7.0

o Web Server Role: IIS 6 Metabase Compatibility
o Web Server Role: (IIS) Static Content
e Web Server Role: ASP.NET

o MSMQ: Microsoft Message Queuing Services, basic functionality only.

e Insbridge User Account

Oracle Software Delivery Cloud

Prior to installation, please make sure the source machine(s) where Insbridge will be loaded has an unzip
utility. An unzip utility for most platforms is available on the Oracle Software Delivery Cloud download

page.

Documentation from Oracle Software Delivery Cloud is in PDF format. Prior to installation, please make
sure the source machine(s) where Insbridge documentation will be loaded has a PDF reader.

Files are downloaded with part numbers as file names. Please make note of the part numbers you have
downloaded and the corresponding file name. You may be asked to provide the part numbers or the
filename if you contact Oracle Support.

The installation downloads you can select are:

o Insbridge Install: Required for all RateManager installations. The Insbridge installation is for a
64-bit system.

o SoftRater for WebSphere: Required if you are using WebSphere

o SoftRater for WebLogic: Required if you are using WebLogic

Oracle Insurance Insbridge Rating and Underwriting Installation Guide Page 11
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o SoftRater for JBoss: Required if you are using JBoss

o Documentation: It is recommended that you download the documentation. Installation guides
and user guides are located here.

The 04.09.00-Insbridge folder contents:

- Databases
¢+ DB2
- SoftRater: IBSR
o DDLs
0 Update: usp_IBSR_v04.07.00.db2
¢ Oracle
- SoftRater: IBSR
o DDL
o0 Update: usp_IBSR_v04.07.00.oracle
¢ SQL Server
- RateManager: IBRM
0 Latinl_General_BIN
= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl_General_CP1_CI_AS
» DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security: IB_CLIENT
0 SQL_Latinl_General CP1_CI_AS
» DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak
- SoftRater: IBSR
0 Latinl_General_BIN
» DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl_General_CP1_CI_AS
= DATABASE BACKUP_IBSR_TEMPLATE.bak
o Update
= Update: usp_IBSR_v04.05.01.sql
= Update: usp_IBSR_v04.06.00.01.sql
= Update: usp_IBSR_v04.08.00.00.sql

- |E7_IE8 Users
¢ Insbridge RateManager Setup Document PDF
¢ RateManager_IE7_IE8.exe

- Oracle Bl Publisher
¢ OBI_PUBLISHER.exe

- Oracle Client
¢ ODAC121012 x64.zip

- Oracle Insurance: Inshridge Enterprise Rating.exe

You are required to run the installation file and create the IB_CLIENT database for any new installation.
The other folders and files may not be needed, depending upon the kind of setup you want. Everything for
a Windows only installation is in the 04.09.00-Insbridge-windows folder. If you want to incorporate a
Java environment, please download the corresponding SoftRater file. SoftRater downloads are not
required if you are running in Windows only.
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Quick View

RATEMANAGER INSTALLATION

Installing RateManager requires that you:
1. Setup Windows. There are a few steps in setting up a RateManager deployment.

2. Install Insbridge using a SQL Server Database.

Setting up Windows

Step 1: Set up an Insbridge User.
Step 2: Verify or activate Windows 2008 web server roles.
Step 3: Verify or install .NET 4.5.

Step 4: Verify SQL Server settings.

Installation Procedures: Full RateManager

Step 1: Install Insbridge Enterprise Rating

Step 2: Configuring Registry Access

Step 3: Creating an Insbridge Application Pool

Step 4: Assigning Permissions: Windows Temp Folder
Step 5: Assigning Permissions: Insbridge Folder

Step 6: Restoring Insbridge Databases in SQL Server
Step 7: Configuring Insbridge Framework Administrator
Step 8: Verifying the Component Services

Step 9: Allowing for WCF Activation

Step 10: Installing the OBI Publisher

Step 11: Starting Insbridge Services

Step 12: Performing Updates in RateManager

Step 13: Export Insbridge Registry Key for Backup
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SETTING UP WINDOWS

Insbridge installers should be familiar with managing a Windows server.

Windows Server should be up and running prior to RateManager being installed. There are a few steps
that should be performed prior to the install:

e Step 1: Set up an Insbridge User. This is a required step.
e Step 2: Setting Windows 2008 web server roles.

e Step 3: Verify or install Windows 2008 features.

e Step 4: Verify orinstall .NET 4.5.

e Step 5: Verify SQL Server settings.

ADMINISTRATIVE USER ACCOUNTS

No administrative account is created when Insbridge is installed. An administrative user account must be
created on the server where the Insbridge system is going to be installed. This required account is the
Insbridge Local User Account.

The Insbridge Local User needs to be a member of the User group and requires certain privileges in order

to fully control the entire Insbridge environment. For ease of installation and if the server is dedicated to
the Insbridge Enterprise Rating System, this user can be added to the local machine Administrators

group.

FILE PERMISSIONS

The Insbridge User requires read/write permissions on:
e The Windows Temp Folder. This is necessary for MSMQ.
e The Insbridge Application Pool Identity

e The Insbridge Folder

The Insbridge user must also be given full control over the following registry key:

e HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge
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Extended Permission Required by the Insbridge User

In order to start the Insbridge services from IBFA, the Insbridge user must be given full access to both the
Insbridge Message Service and the Insbridge Task Manager Service. If the Insbridge user account will
not have full administrative permissions on the server where the Insbridge Framework is installed, then
certain operations from IBFA will not be available. A system administrator may be required to start the
Insbridge services from the server.

Insbridge User Password

The password can be set to any password that meets your company standards. The Insbridge
administrator must make note of the password for future configuration.

For ease of maintenance, the Insbridge user should not have to change the password and the password
should never expire.

The installation automatically applies the Insbridge user name and password to the necessary libraries,
virtual directories and, if used, Internet Proxy settings in IBFA. If you change the Insbridge user password,
you will have to change the password in all three of the Insbridge Com+ libraries, all three of the Insbridge
virtual directories and, if you are using it, the Internet Proxy settings in IBFA.

NOTE: Please note that if your company requires passwords to be re-set, you will have to make changes
to the COM+ Application libraries, virtual directories and if you are using it, the Internet Proxy
settings in IBFA after you change your password. You also may re-install the application. This
recreates the COM+ applications, virtual directories and IBFA instance with the updated Insbridge
user password.

Installer Permissions

The installation program requires that the installer have administrator rights on the machine where the
install is occurring. The install must be run as administrator.

NOTE: If the Installer has permissions, an Insbridge User account can be created from within the install.
If you create an Insbridge user from the install, you may not be able to set the permissions you
need. Please be sure to verify the proper permissions are in place before continuing.

DATABASE USER ROLES AND PERMISSIONS

If a more granular approach is required for management of security of the nsbridge databases, then the
following guidelines can be used to set permissions.

NOTE: These are only guidelines. If not properly configured, certain processes within the Insbridge
Enterprise Rating System will fail. An experienced database administrator’'s expertise is highly
recommended before making any security changes.
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An ibru account must be created for the Insbridge application.

Recommended RateManager Permissions:

It is recommended that the IBRM and IB_CLIENT database user have:

e A database owner (db_owner) role. db_owner access is needed to execute the Insbridge
stored procedures and have full access to the Insbridge schema.

o Disk Admin permissions are also recommended in order to create backups within
RateManager.

For the IBRM and IB_CLIENT databases, if db_owner permissions are not possible, the database will

need to be updated manually. If disk admin permissions are not allowed, backups will have to be done
outside of RateManager.
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STEP 1: INSBRIDGE LOCAL USER ACCOUNT SETUP

Before starting the installation, create a local user account where the Insbridge Framework is being

installed.

To Create a New User:

1. Select Start->Administrative Tools—> Server Manager.

2. Select Configuration->Local Users and Groups.

w

Select Users.

E

E,, Server Manager

File Action Wiew Help

Right click and select New User.

9 [=] B3

e fmlc=HE

% Server Manager (WINSRPOO1)

Actions

Confirm password:

o Rales —
= Eeotires Name Full Mame Description
Zm Diagnostics _&Jndmin Account For [GEU IT Access Do nok change
=] 3?!- Configuration &Admin\strator Built-in account For administering the. ..
i - . i - }
Task Scheduler ! New User EE esstot...
‘Windaws Firewall with Adve i
5 Services 2 )
WM Control !‘ Uszer name: ||
= %& LEcal Users and Groups Full name: I
| Users
. 3 Groups Diescription: I
25 storage
Password: I

N
|

¥ User must change password at next logon
™| User cannet change password
I~ | Password never expies

[~ Account is disabled

Help |

|

2

Users
Mare Actions
Insbridge

More Actions

Figure 1 Creating New User

expires.

6. Click Create.

Add a new Insbridge user. Enter user name and password information. Uncheck User must
change password at next logon. Check User cannot change password and Password never

Close the Add New User screen and select the Insbridge user. Right click and select Properties.

Oracle Insurance Insbridge Enterprise Rating Installation Guide Page 17



Chapter 2 — Setting Up Windows

8. The Insbridge User should be assigned to the local Users group and have the same permissions
as the internet guest account.

Ideally, the Insbridge user should be added to the local Administrators group. If the Insbridge user
cannot be a part of the local administrators groups, please make sure that the Insbridge user has
permissions on the Insbridge Messaging Service and the Insbridge Task Manager Service.

Insbridge Properties HE I

Femate cantral I Terminal Services Profile I Dhial-in I
General I Member Of I Prafile I E nwiranment | Sessiong
* Insbridge
Full narme: Ilnsbridge
Deszcription: Inzbridge Uzer

™| User must change password &t nest logon
¥ User cannot change pazsword

v Paseword never expires

[T Account is dizabled

[T Aceount s locked out

k. I Cancel Amply Help

Figure 2 Adding User information

9. Click OK. Please keep the Insbridge user information close at hand. You will need it for the
installation.
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STEP 2: WINDOWS 2008 WEB SERVER ROLES

Windows 2008 requires that certain web server roles are in place prior to running the install.
e Web Server Role: IIS 6 Metabase Compatibility
e Web Server Role: (1IS) Static Content

e Web Server Role: ASP.NET

Eh Server Manager

el S |

File Acton View Help

Nl A i
5--‘ Roles e i  elhi i) T L S i iili O
7| Features

¥ Diagnostics + View the health of the roles installed on your server and add or remove roles and features.
it Configuration =
=5 Storage

(~) Web Server (IIS) Web Server (II5) Help ||

Provides a reliable, manageable, and scalable Web application infrastructure.

(~) Role Status 7 Go to Web Server (115)

Messages: MNone
System Services: 3 Running, 1 Stopped
Events: None in the last 24 hours

() Role Services: 13installed S Add Role Services

e T stats T & Remove Role Services
& Web Server Installed
& Common HTTP Features Installed L
& Static Content Installed
& Default Document Installed
Directory Browsing Mot installed
HTTP Errors Mot installed
HTTP Redirection Mot installed
[Q'J, Application Development Installed
& ASP.NET Installed
& \NET Extensibility Installed
ASP Mot installed
CaGl Mot installed
& ISAPI Extensions Installed
& ISAPI Filters Installed
Server Side Indudes Mot installed
Health and Diagnostics Mot installed

HTTD | nnaninn Rlat inctallad LI
o~
%.¢ LastRefresh: 5/26/2011 2:09:41PM Configure refresh

|
Figure 3 Windows 2008 Web Server Roles
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To Add a Role:

1. Start-> Administrative Tools—> Server Manager—> Roles—> Web Server (11S)=> Add Role Services.

E,= Server Manager
File  Action View Help

&= 25|

f}.r Roles
= Features
Diagnostics " View the health of the roles installed on your server and add or remove roles and features.

fm; Configuration i
22 storage —

Basic Authentication Mot installed
Windows Authentication Mot installed
Digest Authentication Mot installed
Client Certificate Mapping Authentication Mot installed
115 Client Certificate Mapping Authentication Mot installed
URL Authorization Mot installed
.‘i, Request Filtering Installed
IP and Domain Restrictions Mot installed
Performance Mot installed
Static Content Compression Mot installed
Dynamic Content Compression Mot installed
.‘i, Management Tools Installed
.‘g'._,u 115 Management Console Installed
115 Management Scripts and Tools Mot installed
Management Service Mot installed
.‘i, 115 & Management Compatibility Installed
.‘g'i_._. 115 & Metabase Compatibility Installed
115 & WMI Compatibility Mot installed
115 & Scripting Tools Mot installed
II5 & Management Console Mot installed
FTP Publishing Service Mot installed
FTP Server Mot installed
FTF Management Console Mot installed
Description:

1156 Management Compatibility provides forward compatibility for
your applications and scripts thatuse the two IIS APIs, Admin Base
Object (ABO) and Active Directory Service Interface (ADSI). You can
use existing IIS 6 scripts to manage the IS 7 Web server.

Figure 4 Adding IIS 6 Metabase Compatibility

2. Install IS 6 Metabase Compatibility.
3. Install Static Content.
4. Install ASP.NET.

5. Close out when complete.
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STEP 3: ALLOWING FOR WCF ACTIVATION

WCF Activation is required for web services. RateManager makes call using IBFA web services. If this is
not activated, users will experience errors.

1. Select Start->Administrative Tools—> Server Manager.

2. Select Features Summary. Scroll through the list to verify WCF Activation has been activated.

Add Features Wizard E3

=

(@1

Confirmation

Progress

Resulks

%}' Select Features

Select one or more Features to install on this server,

Eeatures:

Description:

= [E .MET Framework 3.5.1 Features {Installed)
MET Framework 3.5.1 (Installed

WCF Activation (Installed)
HTTP Activation (Installed)
T o T Sty anon
[] Background Inteligent Transfer Service (EITS)
|: BitLocker Drive Encrypkion
[] BranchiCache
|: Zonnection Manager Administration Kik
[ Deskrop Experience
|: DirectAccess Management Console
[] Failover Clustering
|: Group Policy Management
[] 1nk and Handwriting Services
] Internet Prinking Client
|: Internet Storage Mame Server
[ LPR Port Monitor
[] Message Queuing
] mulkipath 1o
| [ Metwark Load Balancing

B =

4

Windows Communication Foundation
— [WCF) Ackivation uses Windows
Process Activation Service bo invoke
applications remokely owver the
netwaork using protocols such as
HTTP, Message Queuing, TCP, and
named pipes, Consequenthy,
applications can start and stop
dynamically in response to incoming
work items, resulting in application
hosting that is more robusk,
manageable, and efficient,

| o

More about Features

= Previaus |

ext = | Install | Zancel I

Figure 5 Selecting WCF Activation

3. Ifnot, select Add Features. The Add Features Wizard is displayed.

4. Select WCF Activation. Click Next.

5. Confirm your selection and click Install. The installation will proceed.

6. Close out when complete.
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STEP 4: VERIFY OR INSTALL .NET 4.5

.NET 4.5 requires .NET 3.5.1 features to be installed prior to installing .NET 4.5. Failure to use .NET 4.5
results in errors when accessing IBFA.

1. Select Start->Administrative Tools—> Server Manager.

2. Select Features Summary. Scroll through the list to verify .NET Framework 3.5.1 Features has
been installed.

. Server Manager [_ O] x|
File  Action ‘iew Help
b A Ealll 7|

ia Server Manager {SLCOSGPT)

5 Roles
ﬁ:j Features
m Diagnostics

: ‘iew the status of Features installed on this server and add or remave features,
Gt Configuration 2
=5 Storage

*! Features Summary E Features Surmary Help
~| Features: 3 of 42 installed A Add Features
ﬂ. Remove Features
Remote Server Administration Tools
Role Administration Tools
‘Web Server (I115) Tools
Windows Process Activation Service
Frocess Model
NET Environment
Configuration APTs
\MET Framework 3.5.1 Features
JMNET Frameveork. 3.5.1
WCF Activation
HTTP Activation

%j\. Last Refresh: Today at 9:42 &M Configure refresh

Figure 6 Verifying .NET Framework 3.5.1 Features

If not, select Add Features. The Add Features Wizard is displayed.

4. Select .NET Framework 3.5.1 Features. Click Next.

Confirm your selection and click Install. The installation will proceed.

You can close out when complete. To assure the registry gets updated with the .NET Framework
3.5.1, restart the system.
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7. After you have verified the .NET Framework 3.5.1 Features, verify that .NET 4.5 has been
installed by opening the registry file.

8. Select Run from the Start Menu.
9. Type regedt32. Click OK. The Registry Editor will open.

10. Browse to HKEY_LOCAL_MACHINE>SOFTWARE->Microsoft>.NET Framework
Setup>NDP->v4->Full.

£ Registry Editor

File Edit View Favorites Help

[ MMC ;I Mame Type | Data |
H- |, Mobile ab|(Default) REG_SZ {value not sek)

] M3Build 24 Install REG_DWORD 000000001 {1)

H- ) MSDE ab|InstalPath REG_ST CHywindows Microsoft, METFramewarkay4, 0, 30319

H

H

H

. MSDTC fit|MsT REG_DWORD 000000001 (1)

e MSF 4| Release REG_DWORD 00005chFS (379893)
4| Servicing REG_DWORD 000000000 (0)

ab oo BEG. S 40,0

ab]version REG_SZ 4,5,51209 |

-

~ |, M3licensing

..... | MSMQ

H- ) MSSQLServer

[+ MapServer

=~ | MET Framewaork Setup

= | NDP
- |, CDF

. we.0.50727

. w30

. W35

o owd

- Lo Client

B £

. w40

""" . Metsh

. Metwork

| MetworkaccessProtection

----- . Mon-Drriver Signing

/- | Mokepad

H- ) ODBC

H- | Office

H- ) Ole

#-- | Outlook Express

|- L PLA

- | PowerShel

£+ | Print

]

H

]

H

]

H

]

-

-5
e

-« . RADAR

- Ras

- | Reliability Analysis
- | RemovalTools

- RFC1156A0ent

- . Router

0 0 O O O o O O o O O e O o O OO O

- . Rpc =
Bl b

|C0mputer'l,HKE\"_LOCAL_MACHINE'!,SOFTWARE'l,MicrosoFt'l,NET Framework. SetupiWDPw4Full 4

Figure 7 Verifying .NET 4.5 in Registry

11. The version should read 4.5. If v4 is not listed or the Full folder is not present, .NET 4.5 has not
been installed. Make sure to look at the v4 folder. DO NOT look at v4.0.

12. If .NET 4.5 is installed, close out the registry and continue.

13. If .NET 4.5 is not installed, you must install before you can continue. .NET 4.5 must be installed
prior to running the Insbridge installation.

NOTE: .NET 4.5 is not included with the Insbridge installation. The .NET 4.5 download can be obtained
from Microsoft.
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Troubleshooting

If you receive an error when accessing IBFA:
Could not load type "System.ServiceModel _Activation._HttpModule® from

assembly "System.ServiceModel, Version=3.0.0.0, Culture=neutral,
PublicKeyToken=b77a5c561934e089

This error may happen when there are multiple versions of .NET Framework on a machine that is running
IIS and did not get registered properly.

Please see http://msdn.microsoft.com/en-us/library/hh169179(v=nav.71).aspx for more information.

STEP 5: MICROSOFT SQL SERVER

Microsoft SQL Server should not be installed on the same machine where the Insbridge web applications
reside. The SQL Server should reside on a separate host from the Insbridge web front end with a properly
configured network connection from the web server front end to SQL Server. Testing can be performed
by using the Data Sources application in Administrative Tools to make a default connection to the
database server.

NOTE: All these settings are available during installation of SQL Server or by using SQL Server
Enterprise Manager, and right clicking the server and selecting properties.

If any of these settings conflict with existing application’s databases residing on the SQL Server,
then a separate instance is required.

Depending on the load expected, the databases can be placed on a separate SQL Server machines that
can either be independent or shared as long as the following conditions are met.

e Server Authentication: Should be set to SQL Server and Windows Authentication mode.

e Collation and Sort Order: Currently supported is the default SQL Server collation using
SQL_Latinl_General_CP1_CI_AS and sort order plus case sensitivity using Latinl_General BIN
as the server collation. The security database (IB_CLIENT) supports the default SQL Server
collation using SQL_Latinl_General_CP1_CI_AS. The RateManager and SoftRater databases
can use either case sensitive or non-case sensitive. Please check with Oracle Insurance for any
guestions regarding database server sort orders or collations.

NOTE: For SQL Server, please make sure the SQL Server Client is installed.
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Chapter 3

FULL RATEMANAGER INSTALLATION

This installation installs RateManager and the Insbridge Framework Administrator (IBFA). This is for a
Windows only environment, using a SQL Server database.
Before installing, please verify that the system requirements are in place.

DEVELOPMENT
The installation should be performed in the following order: Raﬂ:nmand_ Rules
uthoring
1. Install the Insbridge application.
2. Assigning Insbridge access to the Registry. '"T;::L:
3. Create an Insbridge Application Pool. 0BI Publisher
4. Assigning permissions to the Insbridge User for the Windows CEEATEN
Temp Folder. This is necessary for MSMQ. You also need to Must be the same
assign permissions to the Application Pool Identity. ielenienments
5. Assigning permissions to the Insbridge User for the Insbridge ADD
DB Connections:
Folder.
6. Creation of the Insbridge databases is next. There are two Cé';"u?l';'
databases that must be in place. R
a. IB_Client
- CREATE:
b. IBRM Logical
Environments:
7. Enter IBFA and Configure:
RM — to hardle
a. Create your subscriber. L
QA_SR - This
b. Add database connections. Cnvionment
8. Verifying Component Services. ﬁiﬁ’::f;tga
9. Install OBI Publisher. 7
10. Start Insbridge Message Service.
. . PURPOSE of this Physical
11. Login to RateManager and perform Insbridge database updates. Environment

12. Create Backup of Registry Key. This environment is for the

creation of rating programs.

This environment also holds
the security information.

The installation must be run as Administrator. === [ feeeccscscsssssssssssssasse==

IB_CLIENT
security

Attach to

holds Rating
& Rules
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STEP 1. INSTALL INSBRIDGE ENTERPRISE RATING

1. Begin with the Oracle Insurance - Insbridge Enterprise Rating Install file.

NOTE: The installation program requires that the installer have administrator rights on the machine
where the install is occurring.

‘;( ;Jv| .+ Computer ~ Local Disk (C:) = Downloads = Inshridge

Crganize - Open Mew Folder

v Eavorites Tarme Date modified Type Size

e Insurance - Insh

il Libraries @ Run as adrministrator
Troubleshoot compatibility

R4 Computer

22| ocal Disk (1) B Scan for threats...

. Downloads Pin ko Taskbar
. inetpub Pin ko Stark Menu
. Inshridge Restare previous versions
. oracle Send to »
. Perflogs
? Cuk

. Program Files Copy
. Program Files (x86)

Create shorbouk

. kemp
| Users Delete
) Rename
. Windows
o Mew Yolume (E:) Properties

Figure 8 Install as Administrator

NOTE: Please close all open applications before running the Oracle Insurance - Insbridge Enterprise
Rating file.
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2. Open the Oracle Insurance - Insbridge Enterprise Rating file. A Welcome screen is displayed.

i'él‘ Oracle Insurance - Insbridge Enterprise Rating Setup M =] |

4 QOracle Insurance Insbridge

[t iz gtrongly recommended that you exit all \Windows programs befare running this setup program.

Click. Cancel to quit the zetup program, then cloze any programs pou bave running, Click Mest to
continue the installation,

WARMIMG: This program iz protected by copenght law and international treaties.

Unauthonzed reproduction or diztnbution of this program, or any portion of it, may result in severe
civil and criminal penalties, and will be progecuted to the maximum extent poszible under law.

ORACLE
INSURANCE

Cancel |

Figure 9 Installing Insbridge

3. Click Next to continue.
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fiz? Oracle Insurance Insbridge Setup I =] |
Destination Folder DRACLE'
Select a folder where the application will be installed.
PR INSURANCE

T he "Wize Installation “izard will inztall the files for Oracle Insurance Insbridae in the
following folder.

To inztall inta a different folder, click the Browse button, and zelect another folder.
'ou can choose not ta install Oracle Inzurance [nsbridge by clicking Cancel to exit the
YWize [nstallation ‘wizard.

C:%Program FilezhOracleh GBS nzbridges Browse |

" Destination Folder

YWize Inztallation Ywizard [R]
< Back

Figure 10 Entering the Destination Folder for Insbridge

4. Choose the location where the Insbridge installation will be installed. A default installation folder is
created for all new installs. This will be the location for all future installations for Insbridge
applications. Select Browse if you want to install in a different location. After selecting a location, click
Next to continue.
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fi? Oracle Insurance - Insbridge Enterprise Rating Setup I =] |

Logon Information DRACLE‘

The following logon information is uzed by Inzbridge. INSURANCE

Specify a uzer account bo be uzed by the application, either far running a service ar far
logging onto ather servers. Uze the Browse button to chooze wzers from pour networl:.
Far damainz, user names must be in the farmat of DOMAINSY zerM ame.

User Mame: |Insl:uriu:|ge Browse. .. |

Password: | sessesss|

Create Mew zer... |

YWize Installabion Wizard®

< Back | Hest » I Cancel

Figure 11 Logon Information

5. Enter the Insbridge user name and password for the local user account you set up earlier. The
logon information screen is displayed. You must specify a user account to be used by the application.
Please use the Insbridge user account that you set up on page 14.

NOTE: You can Create a New user at this point, if needed. Click the Create New User button to be
placed on New User screen to setup an Insbridge user.

6. Click Next to continue.
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i'él‘ Oracle Insurance - Insbridge Enterprise Rating Setup M=l |
Select Features ORACLE
Pleaze select which features you would like toinstall.
Y INSURANCE
[ {Q v| Inzbridge Enterprize Fating Feature Description:
""""" %’ R atetd anager Oracle Insurance Insbridge E nterprize Fating is
= hd B -3 a‘web-bazed rating, rules, and undenariting
suskem.

Thiz feature will be inztalled on the lacal hard
drive.

| iz heature requires UKE an your hard drve. |t
haz 2 of 2 subfeatures selected. The
subfeatures require 168 an your hard drive.

YWize Inztallation Ywizard [R]

Digk Cozt Reszet

Figure 12 Selecting Features for Installation

7. The next screen lists the applications to be installed. To expand the options and view details, click on
the downward arrow. All features are checked for installation. RateManager is the only one that you
will be allowed to not install. Click Next to continue.

Options are:

e Oracle Insbridge Insurance:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

e RateManager:
- The default option is: Entire feature will be installed on local hard drive.

- You will be able to opt out of this option. Select Entire Feature will be unavailable.
RateManager will not be installed.

e |IBFA:

- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.
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fi? Oracle Insurance - Insbridge Enterprise Rating Setup I =] |

Ready to Install the Application ORACLE

Click, Mext to beqgin inztallation. INSURANCE

Click the Back button to reenter the installation infarmatian ar click Cancel to exit
the wizard.

YWize Inztallation Ywizard [R]
< Back

Cancel |

Figure 13 Ready to Install

8. A Ready to Install screen is displayed. If you are ready, click Next. Otherwise click Back to check the
options you want to install.

9. The installation displays the progress.
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fi? Oracle Insurance - Insbridge Enterprise Rating Setup I =] |

4 Oracle Insurance Insbridge

Oracle Insurance - Insbridge
Enterprise Rating has been
successfully installed.

Click the Finizh button to exit thiz inztallation.

ORACLE’

INSURANCE

Cancel |

< Back

Figure 14 Install Finish Screen

10. Click Finish to finish the installation. The installation should complete successfully.
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STEP 2: CONFIGURING REGISTRY ACCESS

NOTE: If you use Registry Editor incorrectly, you may cause serious problems to the operating system.
These problems may require you to reinstall your operating system. Insbridge cannot guarantee
that you can solve problems that result from using Registry Editor incorrectly.

By default, only administrative and power user accounts have full permissions over this key. The
Insbridge user must also be given full control over the following registry key:

HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge
Assigning Permissions for the Registry Access

1. Select Run from the Start Menu.

2. Type regedt32. Click OK. The Registry Editor will open.

&' Registry Editor

File Edit Wiew Favorites Help

=M Computer Marne Type | Drata

, HKEY_CLASSES_ROOT ab]{Default) REG_SZ (value not set)
. HEEY_CURREMT _USER
. HEEY_LOCAL_MACHIME
. BCDOO000000

. COMPONEMTS

. HARDWARE

. SAM

""" . SECURITY

[+ SOFTWARE

- Classes

) Clients

ALt ]

J Hewlett-Packard

Expand
Mew 3
Find...

Delete
Rename

E

Copy Key Mame

----- . Registeredapplications
F- | WOWE43ZNode
- . SYSTEM

[+ | HKEY_USERS
[+~ . HKEY_CURREMT_CONFIG

]
[+

|ComputeriHKEY_LOCAL_MACHINE\SOFTWAREInsbridge 4

Figure 15 Configure Registry Access Windows Server
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3. Browse to HKEY_LOCAL_MACHINE. Select SOFTWARE-=>Insbridge.

4. Right click and select Permissions.
5. Scroll through the users. Select the Insbridge user.
6. Verify that the Insbridge user has Full Control.

7. If the Insbridge user does have Full Control, cancel out of the registry and continue with the
installation.

8. If the Insbridge user does not have Full Control, change permissions to allow for Full Control.
Save your entry and close out the registry. Continue with the installation.

9. If the Insbridge user is not listed, follow the step to add the Insbridge user.

Adding the Insbridge User:

1. From the Permissions screen, click Add.

2. Onthe Select Users or Groups popup, you can leave the defaults for the Object Types and
Locations or enter the values you require.

select Users or Groups E E

Select thiz object twpe:

ILlsers, Groups, or Built-in zecurity principals Ohbject Types. .

Erom thiz location:
ISEFWEFE Locations...

Enter the object names to select [examples]:
Inzbridge] Check MNames

FEE

Advanced... | k. | Cancel

Figure 16 Entering the User

3. Enterin the user name (Insbridge) and click Check Names. If the user name is found, it will be
listed. If the name is not found, an error screen will be displayed. Cancel out and to return to the
Select Users or Groups popup. Click Advanced to search. To search the directory, click Find Now
and scroll through the list until you find the user name you need. If the user name is not listed,
return to User Accounts and verify the user name was created.

4. Once the name is listed, click OK.
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. Permissions for Inshridge I
Security |

Group or user names:

5% CREATOR OWNER

51 SWSTEM

l, Inzbridge [SERYER I nzbridge]
‘:ﬂ,.-’-'-.dministratnrs [SERVERMAdminiztratars]
"‘ﬂ, Uzers [SERWYERY zerz)

Add... | Bemove |
Pemizzions for Inzbridge Al Deny
Full Cantral O
Fead O
Special permizsions O O

Faor zpecial permizzions or advanced zettings, Advanced |
click Advanced. -

| earn about access control and permizsions

| QF. I Cancel | Apply |

Figure 17 Applying Permissions

5. On the Permissions screen, make sure the Insbridge user is highlighted and check to give Full
Control to the entire Insbridge key.

6. Click OK.

7. Close the registry and continue with the install.

Oracle Insurance Insbridge Enterprise Rating Installation Guide Page 35



Chapter 3 — Full RateManager Installation

STEP 3. INSBRIDGE APPLICATION POOL

Insbridge requires .NET framework setting of v4.5. This may present conflicts with other applications in

the default application pool that require a higher setting. To avoid conflict and improve performance, a
separate Insbridge Application Pool must be used.

Verify the Insbridge Application Pool

A default Insbridge Application Pool is created at installation. This pool ORACLE_FSGBU_INSBRIDGE

should be used for the Oracle applications. Please verify that the Insbridge web applications are
associated with the new Insbridge application pool.

1. Click Start > Administrative Tools = select IIS Manager.
2. Expand the Local Computer and select Application Pools. Verify the

ORACLE_FSGBU_INSBRIDGE application pool, the Identity is Insbridge and that there are 3
applications associated. If the pool is correct, proceed to the next step.

@ L [.:.’ ¥ SERVER * Application Pools

| &
Fle Wiew Help
_ @1 Application Pools _A
€ - | £ |&. %: &=, Add Application Poal...
%5 Start Page Set Application Pool Defaulks, ..
E| 5 SERVER This page lets you view and manage the list of application poals on the server, Application pools are associated with worker e
j ) applicatian Poals processes, conkain one of more applications, and provide isolation among different applications., aApplication Pool Tasks
TS
=& Stes Filker: w G - gk Show sl | Groop by po Grouping - B Start
=|- () Default weh Sit
= @ e ZL; ne: ch;net hame = | Status | .MET Frame. .. I Managed Pipeli. .. | Identit: | Applications | & Stop
3 IB£ . L ASPUNET w40 Started w40 Integrated ApplicationPooliden... 0 o Recycle..,
3
insbridge = ASP.NET w40 Classic Started w40 Classic applicationPoollden.,. 0 Edit Application Pool
MSMO ‘;'.’Classic MET AppFool Started wz.0 Classic ApplicationPoolIden,,, 0O : :
=1 - D Basic Settings...
W RM 4= DefaultAppPool Started w20 Inkegrated ApplicationPoolIden... 2

ORACLE_FSGBU_INSERIDGE ~ Started

Integrated Insbridge Recycling...
Advanced Settings., ..
Rename

K remove

View Applications
"9 Help

Online Help

Ready

If the ORACLE_FSGBU_INSBRIDGE has not been created, you will have to create one. Please see
Appendix A, Creating an Application Pool.
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STEP 4. ASSIGNING PERMISSIONS: WINDOWS TEMP FOLDER

Permissions must be assigned for the Windows Temp Folder for MSMQ and for the application pool
default identity. Prior to assigning permissions, please verify the Insbridge application pool identity.

Assigning Permissions in the Windows Temp Directory:

1. Find the WINDOWS folder, most likely on your C drive.

2. Right click the Windows->Temp folder.

. Temp

G( )v | + Server » Local Disk (C:) = ‘Windows « Temp = - lmJ I Search Temp re)
Organize *  Includein lbrary +  Sharewith = Mew Folder = - E] ﬂ
Panther ;I Marme = | Date rodified Type | Size
FLa hsperfd & Fald
ta_SERVER: 11/15/2014 10:24 AM  Fil
PalicyDefinitions & hepertasta_ ¥ 18f e fodsr
Registration || pMISADC tp 11j15/2014 350 AM  TMPFile
RemotePackages 4 | FirstPatchPassDone ini 1117/2014 114 PM Configuration settings
rescache Expand DebuglogFile. bxk 3/12/2014 2:00 AM Texk Docurnent
Resources ) . FDebuglagFile kxt 3/12/2014 2200 M Tewt Document
=chcathe Open in ne window
all=d.ini 11/17j2014 &:11 PM Configuration settings
schemas Share with 3
) Log 11/17)2014 9:20 PM Text Document
secuity B Scan for threats
ServiceProfies 0.ini 11/17j2014 8:11 PM Configuration settings
servicing Restore previous yersions stalled.ini 11}17j2014 &:43PM  Configuration settings
Setup tuebaelz (7 s, ¥ Ndress.ini 11j17)2014 &:10PM  Configuration settings
SaoftwareDistriby - Zend ta * [fig_2014-11-17 2047 lag 11/17/2014 551 PM  Text Document
Speech Cut Fig_2014-11-15_0255.log 11/18/2014 357 &M Texk Document
SysMsiCache
b Copy dation.log 11/18/2014 4:05 &AM Text Document
syskem B ) ] ]
System3z Delete tMame.ini 11/17)2014 9:15 PM Configuration settings 3
SysWOWE RSN ll.reg 11/18/2014 4:03 AW Reqistration Entries
TAPI N F hsEdition.reg 11172014 215 PM Reqistration Entries 3
Tasks
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'u'ss- LI 7 I I LI
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Figure 18 Assigning Permissions for the Insbridge User on Windows Temp

3. Select Properties. The Temp Properties screen opens.

4. Select the Security tab.

5. Click Edit.

Oracle Insurance Insbridge Enterprise Rating Installation Guide Page 37




Chapter 3 — Full RateManager Installation

6. On the Permissions for Temp screen, select the Insbridge user and click Add. If the Insbridge
user is not found, cancel out and return to the Local Users and Groups area in Server Manager
and verify the Insbridge user was created.

7. Update the permissions. The Insbridge user requires Full Control.

M Temp Propetties I
. Generall Sharing S ecurity | Previouz Wersions | Eustu:umizel

Object name:  C:A\WindowshTemp

Group or user names:

52 CREATOR OWNER
82 5YSTEM

Inzbridge [ SERMER. W nzbridge]

-
w? & drminiztrabars [SFRYFRYE drainichrabaes] hl
4 | v
To change permiszions, click Edit. Edit . |

Permiszions for [nsbridge Billons Dery

Full contral
b odify
FRead & execute

FY

Lizt folder contents
Read
Wwirite

For special permizzions or advanced settings, Advanced |
click Advanced. =

Learn about access contral and permizsions

| QF. I Cancel | Apply |

Figure 19 Temp File Properties

LAENASNS

-

8. Click OK to close the Permissions for Temp screen.

9. Click OK to close the Temp Properties screen.
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STEP 5. ASSIGNING PERMISSIONS: INSBRIDGE FOLDER

Assigning Permissions for an Insbridge Folder Location
1. Locate the Insbridge installation directory. If you selected another directory when installing the
Insbridge application, go to that directory. The default installation directory is located at:
C:\Program Files\Oracle\lnsbridge.

2. Right click the Insbridge folder.

l Insbridge =]
(;( )v | = Server + Local Disk {C:) = Program Files = Oracle = Insbridge - - lmjl Search Insbridae m
Organize = Include inlibrary *  Sharewith = Rlew folder o E] IZ:.EZI
=&, Local Disk (C2) 2l name - | Date modified Tvpe | Size
38dccalf724de3d16a e Fold
£70da0623235bd91 260633253604 oM+ 11/13/2014 11:56 AM - File Folder
ekc Framewark, 11/18/2014 11:56 AM  File Folder
M@ fscabaasafochy 1Faafssadf2e SDK 11/15/2014 11:56 &AM File Folder
inetpub SaoftRater 11/13/2014 11:56 AM  File Folder
Oracle webs 11/15/2014 11:56 &AM File Folder
=] Prograrm Files
7-Zip
AboutTime
Commion Files
Internet Explorer
M3Euild
MetConfig
=] Oracle
l Insbridge Expand
Irvventary
Profile Copier Qpen in new window
Reference fisse Share with 4
System Configu
* Y J B 5can for threats. ..
LIty g
windows Mail Restare previaus versions
Windows NT Include in library 4
Program Files (x8  Send ko »
Tem|
U F Cut
Sers G
Windows
L Builds Celete
Rename
?ﬂ Metwark, Mew > I _'I
3 items

Figure 20 Assigning Permissions for the Insbridge User on Insbridge

3. Select Properties. The Insbridge Properties screen is displayed.
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4. Select the Security tab.

5. Verify that the Insbridge user created earlier is assigned to the directory and has Full Control. If
the Insbridge user is listed and has Full Control, proceed to the next step.

M insbridge Properties I
. Generall Sharing S ecurity | Previouz Wersions | Eustu:umizel

Object name:  C:A%Frogram FileshOracletnsbrdge

Group or user names:

52 CREATOR OWNER
82 5YSTEM

Inzbridge [ SERMER. W nzbridge]

-
A dministratars [SFRYFRY & dAriniztratars] hl

4 | v
To change permiszions, click Edit. Edit . |

Permiszions for [nsbridge Billons Dery

Full cantral =
b odify

Read & execute
Ligt folder contents
Read

Wrike
For special permizzions or advanced settings, Advanced |
click Advanced. =
Learn about access contral and permizsions

| QF. I Cancel | Apply |

Figure 21 Insbridge Folder Properties

LAENASNS

-

6. If the Insbridge user is not listed, click Edit. On the Permissions for Insbridge screen, select the
Insbridge user and click Add. If the Insbridge user is not found, cancel out and return to the Local
Users and Groups area in Server Manager and verify the Insbridge user was created.

7. Update the permissions. The Insbridge user requires Full Control.

8. Click OK to close the Permissions for Insbridge screen.

9. Click OK to close the Temp Properties screen.
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STEP 6: RESTORING INSBRIDGE DATABASES IN SQL SERVER

Because many corporate environments have a separation between the system administrator and the
database administrator, the following process may require both administrators’ access and permissions.
Make sure you have a SQL Server account called ibru.

NOTE: If you do not have database permissions, you will not be able to perform the following database
procedures.

NOTE: If you are unsure how to perform a database restore, please consult with your database
administrator.

Currently supported is the default SQL Server collation using SQL_Latinl_General_CP1_CI_AS and sort
order plus case sensitivity using Latin1l_General_BIN as the server collation. The security database
(IB_CLIENT) supports the default SQL Server collation using SQL_Latinl_General_CP1_CI_AS. The
RateManager and SoftRater databases can use either case sensitive or non-case sensitive. Please check
with Oracle Insurance for any questions regarding database server sort orders or collations.

1. Located in the Insbridge Installation Directory:

¢ SQL Server
- RateManager: IBRM
0 Latinl_General_BIN
= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl_General CP1_CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security: IB_CLIENT
0 SQL_Latinl_General_CP1_CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak

2. Select the RateManager backup file you want to use, case sensitive or non-case sensitive. The
Security: IB_CLIENT file is only non-case sensitive.

3. Copy both files to an appropriate database folder on the machine where SQL Server is installed.
For example, [Drive]:\\Program Files\Insbridge\Databases. If you are unsure of a location, please
consult with your database administrator.

4. Rename files. It is not required but it is strongly suggested that the database file names be
changed from TEMPLATE to something that defines the databases more accurately. At a
minimum, it is recommended that you remove “*_ TEMPLATE” from the name. You can change the
names after they have been restored also.

5. Open the SQL Server Management Studio either on the server or remotely using either an
administrative account with sa privileges or as the sa account.

NOTE: If you do not have SQL Server Management Studio, check to see that the SQL Server Client has
been installed. For a SQL Server install, you must have the SQL Server Client installed.
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Figure 22 Restoring a Database to SQL Server
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Figure 23 Right Click to Restore Database
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7. Right click on Databases.

8. Select Restore Database... A separate screen is displayed.

. Restore Database - IB_CLIENT_Alamere M=l
Selecta L8 Script + L% Help

% General

147 Options

Desztination for restore

Select or type the name of a new or exizting database for pour reztore operation.

Tao database: IIB_ELIENT_#‘«IamerE j
To a paint i e IMnst recent poszible |

Source for restare

Specify the source and location of backup sets to restore.

£ From database: I j
' From device: IE:\Insbridge'\DB_EIean'\lB_ELlENT.I:uak |
Select the backup zetz ta restare:
R estare | I arne | Compoett | Ty | Server | Databaze I Pasitic
d Database Full DEwOm |IB_CLIENT_TEMPLATE 1
Server
WINAPD1YS L
Connection:
23
3¢ View connection properties
< | |

Ok I Cancel |

A

Figure 24 Restoring a Database

9. Enter your IB_CLIENT database name in To Database:.

10. Select From Device. Click ... to browse to the location where the database files were placed in
step 3.

11. Select your database IB_CLIENT_ xxxx.BAK, where xxxx equals the renamed file from step 4.
12. Click OK. Your database will be populated.

13. Verify your information. Check the Restore box.
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14.

15.

16.

17.

Click OK.

If the database was restored successfully, it will be displayed in the database folder. If not, please
correct any errors and try again.

Repeat for the RateManager database and any SoftRater database.

Once the databases are restored to SQL Server, you will need to create or assign a SQL Server
user account for the application. This user will be used for the connection to the databases when
setting up the connections from the Insbridge Framework Administrator. Make note of the account
you want to use. This information will be entered into the Insbridge Framework Administrator.

If backups are to be allowed from the RateManager application (see page Error! Bookmark not
defined. for more details), then the ibru SQL server user account must have the Disk
Administrators SQL Server role.

For ease of administration, the database user should have db_owner permissions on the
IBRM_xxxx, and IB_CLIENT databases.
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STEP 7: CONFIGURING INSBRIDGE FRAMEWORK ADMINISTRATOR

Open an Internet Explorer web browser and browse to the following location, replacing SERVERNAME
with the actual server name:

http://SERVERNAME/IBFA

Logging in to IBFA

The default security setting for a new installation is Custom and requires a login to access.

e@ e http://localhost/IBFAS P~ B0 | & Framework Administrator (.., %
ORALCLE msurance Insbridge Framework Administrator Version 04.09.00 (x64)
Show FrameworkAdmin Menu I

Explorer not configured. Please contact your system administrator.

-~

Click “Show FrameworkAdmin Menu”
\ to display login options.

Figure 25 IBFA Landing Page

1. IBFA requires a login to access. Click the Show FrameworkAdmin Menu link to display the login.
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\ fliEl s
@ () & http://localhost/IBFA/ p-2c
ORACL_E nsurance Insbridge Framework Administrator Version 04.08.00 (x64)

B fccess Serure Services Ezplorer not configured. Please contact your system administrator,
User ID:

Password:

Figure 26 IBFA Login Screen

2. Enter the default User ID and password:

User ID: admin
Password: insbridge

3. The IBFA home page is displayed.

Updating IBFA Security
4. Itis recommended that you change the login password immediately. You do not have to change

the password.

5. On the left side menu, select Security-> Change Password.
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= Insbridge
- SoftRater
- SoftData
-l Services
[#-_J Logs
- Security
£
-8 softlibraries
@) Help

Change 'Custom Security’ Admin Password

Insbridge suggests that you use a password that is 6-8 characters lang. If you think someaone else knows the admin
password, please contact your system administrator.

Old Password
New Password

Confirm Password

Update

Figure 27 Updating the Default Password

6. Enterin the default password for the old password and enter in the new password of your choice.
Confirm the new password and click Update. A success message is displayed when the admin
password is updated. If an error message is displayed, make corrections and try again.

7. If you do not want to require a login, you can change the security to None. This changes the
default landing page to the IBFA home page and removes any login requirements.

8. On the left side menu, select Security.

9. Select None for Framework Administration Web Security for no security. The landing page will be
updated the IBFA home page and no login will be required.

=3 Insbridge

-1 SoftRater

- SoftData

-l Services

-1 Logs

5|

.__.I Change Password

422 Softlibraries

- @) Help

Framework Administration Web Security

To utilize Windows authentication please select the Windows security option and contact your system administrator to
update your IIS settings. The Insbridge Custom Forms authentication requires that you enter an admin user and password
combination for web access,

) None
() Windows
@ Custom

[] allow unautherized users to view secure environments? {read-only)

External API Access

The Insbridge Framewaork Administrator has an open AP for back-office system automation. To allow an external process
to connect to this node, enable and set the access key below.

() Disabled

(@) Enabled |ce8de543-00d5-4bd3-87ca-f481bs237578 Generate Key

Figure 28 Selecting Security for IBFA

NOTE: You also can select to use Windows security. Please see the IBFA user guide for more
information on setting up Windows security.
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Entering Company Information

Prior to users entering RateManager, the Insbridge Framework Administrator must be configured for your

company.
s [E=REEE™C)
e Y[ @ http://localhost/IBFA/ p-2¢|
ORACL & msurance Insbridge Framework Administrator Version 04.09.00 (x64)
[
=B Confiquration File [C:\PROGRAM FILES\ORACI E\TNSBRIDGE \FRAMEWORK\4.5.0\Insbridge Xml]

3 SofRater The Framework Administrator Web will configure any Insbridge Framework Configuration file (Insbridge. xml) found on your
: network. Although all Insbridge Applications may have their own version of this configuration file, we suggest that all apps
#[ 1 SoftData that reside on the same Framework Server share the same file.

i+ Services
-4 Logs
Security
#4553 Softibraries
@) Help

Change Config File location: Edit| | Apply

Click on "Edit” button to enable the text box above. Copy and paste the new Insbridge XML file location in the text box,
Then dick on "Apply” button to apply the new configuration file.

The subscriber identifier is an unique number that you would like to represent your company. Please consult with an
Insbridge support representative if you have any questions.

Click on the id of the subscriber in the list to edit.

# No Subscribers found.

Add Database Connection

Create or edit database connection. This database connection can be global to the Insbridge Framework or unique to the
Subscriber.

Click on the name of the connection to edit.
£2 Global

# No Connections found.

Copyright © 2000,2009, Oracle andjor its affilates. All ights reserved.

Figure 29 IBFA Home

NOTE: If you receive an access denied error message, please verify that you have given the Insbridge

user full contr

ol of the Insbridge folder.

NOTE: If you receive an IDNX denied error message, please verify that the Insbridge user has full control

over the Insbridge directory. Regedt->Insbridge Directory-> Security.

NOTE: If you receive an error regarding MCSiMenuCltl, please verify that you are using Internet Explorer
8.0 or 9.0 (32-bit). Release 04.09.xx does not support Internet Explorer 8.0 or 9.0 (64-bit).

There are five steps that need to be done in IBFA:

e Step 1. Creating a New Subscriber
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e Step 2. Adding a Global Database Connection
e Step 3. Adding a Security Database Connection
e Step 4. Adding an RM security Database Connection

e Step 5. Creating a RateManager Environment

Step 1: Creating a Subscriber:

A subscriber is a group or collective of users and environments under a single identity. This identity is
used to manage and configure the group’s activities and databases. A subscriber may be a single
company, a group within a company, or a single person.

The ID, Name and Description are selected by you. The ID and Name are fixed after the first time you
save. These entries cannot be edited. Only the description can be edited.

1. Click on Add Subscriber on the Main IBFA screen. A separate screen is displayed.
2. Enter the ID, Name and Description for your subscriber.

3. When you finish entering the information, click Save. The new subscriber will now be displayed in
the list of subscribers.

# | Subscriber -- Webpage Dialog &J

Subscriber
Flease enterfupdate your Insbridge Customer information below.,

ID: 3659
Mame: Alamere

Desc:  Alamere Insurance

Save Cancel

L

Figure 30 Enter ID

NOTE: Make note of the subscriber ID number. You may need to enter this on another IBFA or IBSS
environment.
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The Subscriber ID can be a 1-5 digit number and must unique for each subscriber. For example,
if you have an instance of IBFA on machine A, you can create a subscriber with an ID of 100. On
machine A, if you create another subscriber, you must give that subscriber a different ID number,
say 200. If you also have an instance of IBFA on a different machine, B for example, you should

duplicate the same subscribers with the same ID numbers on machine B.

If you require assistance or are unsure of what action to take, please log a Service Request using
My Oracle Support at https://support.oracle.com/.

Next Step: Add Database Connections:

Stay on the Main IBFA screen. Three databases must be added to IBFA:

e Subscriber: Global with Name: controller. This is a global database and is required for logging in
to the Insbridge system. This is not unique to the subscriber.

e Subscriber: (Your Subscriber Name) with Name: security. This is a subscriber specific
database and is required for subscriber security information.

e Subscriber: (Your Subscriber Name) with Name: RM. This is a subscriber specific database and
is required for RateManager. This information will also be used when creating the RateManager
environment.

The setups are similar for all three databases. The description information following the first example will
be the same for the other two databases.

NOTE: If you have renamed the databases, please make note of the new names.

To continue, you will need to exact names of the databases you restored in Step 5, IBRM_xxxx, and
IB_CLIENT databases.
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Step 2: Adding a Global Database Connection:

Begin by filling out connection information for the IB_CLIENT database using the Global subscriber.

1. From the Insbridge page, click the Add Database Connection link. This opens the Connection

screen.
-
& | Connection -- Webpage Dialog [iF-J
Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber.
Subscriber: Global -
Mame:; Controller
Server: LocalHost Test Connection...
Server Type: SQLServer -
Cataloq: IE_CLIENT
Catalog Type: Other -
Query Buffer:
Tablespace:
Schema:
User: 53
Passwaord: TIIIIIL
Save Cancel
e .

Figure 31 Setting up the Global Database Connection

2. Select Global for the Subscriber.

3. Enter Controller for the Database Name. The name must be Controller. This cannot be changed
once you have saved it.

4. The Server is the database server name or IP address whichever is resolvable by the Insbridge
web server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases are all SQL Server.

6. Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 5.
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7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type
RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed.

Step 3: Adding a Security Database Connection:

1. Next, add the security database. Select the Add Database Connection link again.

2. Select Your Subscriber. The security database is unique to the subscriber.

& | Connection -- Webpage Dialog [i_E-J

Connection
Database connections can be global to the Insbridge Framework or unique to the Subscriber.

Subscriber: Alamere Insurance -
Mame: Security

Server: LocalHost Test Connection. ..
Server Type:  S0LServer -

Cataloq: IE_CLIENT

Catalog Type: Other -

Query Buffer:

Tablespace:

Schema:

User: 53

Password: I

Save Cancel

Figure 32 Setting up the Security Database Connection
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3. Enter Security for the Database Name. The name must be Security. This cannot be changed
once you have saved it.

4. The Server is the database server name or IP address whichever is resolvable by the Insbridge
web server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

6. Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 5.
7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type

RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller

database will be listed

Step 4: Adding an rm Database Connection:

1. Next, add the rm database. Select the Add Database Connection link again.
2. Select Your Subscriber. The rm database is unique to the subscriber.
3. Enter rm for the Database Name. This cannot be changed once you have saved it.

4. The Server is the database server name or IP address whichever is resolvable by the Insbridge
web server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

6. Enter IBRM_xxxx for the Catalog. This is the RM database you restored in step 5.
7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type

RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed

Oracle Insurance Insbridge Enterprise Rating Installation Guide Page 53



Chapter 3 — Full RateManager Installation

& | Connection -- Webpage Dialog [—?hj

Connection
Database connections can be global to the Insbridge Framework or unique to the Subscriber.

Subscriber: Alamere Insurance -
Mame: RM

Server: LocalHost Test Connection. ..
Server Type:  S0QLServer -

Cataloq: IERM

Catalog Type: |(ERIEIEr ol ~

Query Buffer:

Tablespace:

Schema:

User: 53

Password: (TTTYTTTS

Save Cancel

Figure 33 Setting up the RateManager Database Connection

NOTE: The Catalog Type must be set to RateManager when you are creating the Connection from
RateManager. If you leave it set to Other, you will receive an error.

Creating Logical Environments:

Next, create the default rating environment for the RateManager system.
For a new installation it is recommended that you create one logical environment:
e RM: to handle rating and testing.
You can create additional environments at this time if necessary or you can add them in at a later time.

Step 5: Creating a RateManager Environment:

It is recommended that only one RateManager environment be created.
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1. Browse to SoftRater>Explorer>Subscriber name.

< JO)

& http://localhost/IBFA/default.aspx

0O - B¢ || @ Framework Administrator (... %

File Edit View Favorites Tools Help

ORACLE 1nsurance nsbridge Framework Administrator Version 04.09.00 (x64) l
[
E-C3 Insbridge

-3 softRater

i [d Engine

i =M Explorer Configuration Add Environment

P —— Environments Add, edit, or remove environments from your Explorer configuration.

[ softData NAME - DESCRIPTION

i+ services.

[ Logs # Mo environments found.

[ security

! dam P

asy Softiibraries N N

@ Help “Your rating book of businesses are identified by an id and a description. There is na limit to the number of LOB's (ine-of-
business) that your Explorer can contain.
D - DESCRIPTION
# No Lines found.
Yirtual File Server Manangement
There are times when you must download SoftRater packages from different locations. These locations require a domain
name of an ip-address of the particular server.
# Mo file servers found.
< >

Figure 34 Create a Rating Environment

2. Click on Add Environment.
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E Environments -- Webpage Dialog -

SoftRater

A SoftRater configuration can support an unlimited number of environments,
Mame: RM
Type: Dev - |
Secure:
| |
T S |

Figure 35 Entering Name and Environment

3. Enter a Name and select a Type. The name and type are totally dependent on how your
Insbridge system is designed.

There are three types of Logical Environments:

e Development
e Quality Assurance
e Production

After you have entered your logical environment, you must define it.

Defining the Logical Environment

ORACL_E msurance Insbridge Framework Administrator

=~ Insbridge
Elﬁ SoftRater
Ej Engine
Eﬁ Explorer Add Environment
FrE——— S e Add, edit, or remove environments from your Explorer configuration.

(3 softData
-0 services # RM - Development
H-[1 Logs # DA - Quality Assurance
03 Security % Prod - Production

Figure 36 Obtaining Environment Information
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1. Select the Environments link under the Configuration header on the left hand side to enter the
configuration information for the newly created logical environment. You will be placed on the
Environments screen. The environments you previously setup will be listed. If an environment is
missing, you must return to the Configuration subtab and add it.

. . - [ESREER =)
e- ) @ hitp:/ocalhost/18FA/ o-2¢]
ORACLE" msurance nsbridge Framework Administrator Version 04.09.00 (x64)
[x]
B3 nsbridge =R
-3 SofRater
: 3 Engine
| EEE Explorer Configuration DEVELOPMENT ~
i i Environments Environment(s) you may use for development purpases. Selecting an environment below will denote it as the default.
13 softpata
£3 Services Environment: RM
3 Logs Package Location: Test Environment...
3 security DB Server:
5 softibraries DB ServerType: SQLServer -
@) rielp DB Catalog:
DB CatalogType: Other -
DB Query Buffer:
DB Tablespace:
DB Schema:
DB User:
DE Password:
Engine Type: Windows -
Engine Location: LOCALHOST [7] Location is a Cluster
Engine EnvDef: Discover
Enviranment{s) you may use for quality assurance purposes, Selecting an environment below will denote it as the default,
|
i Enviranment: QA
| Package Location: Test Environment...
DB Server:
DB ServerType: SQLServer -
DB Catalog:
DB CatalogType: Qther -
DB Query Buffer:
DB Tablespace: i
DE Schema: v
Copyright © 2000, 2009, Oracle and/or its affiliates. All rights reserved.

Figure 37 Editing Environment

2. The Environment Name will be complete. No changes are needed.

3. RateManager environments will not have a Package Location. No entry will be allowed.

4. Enterin the DBServer name or IP address. This is the database server where the RateManager
database was restored.

5. The DB Server Type will be SQL Server.

6. The DB Catalog is the name of the RateManager database restored in SQL Server.

7. The DB Catalog Type is RateManager.

8. DB Query Buffer, DB Tablespace and DB Schema are not required for a RateManager

environment.
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10.

11.

12.

13.

Enter the DB User name and Password.
The Engine Type is Windows.

The Engine Location default is LOCALHOST. Most RateManager installations have a local
engine location. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located. Do not change LOCALHOST to the name or IP
address of the local machine.

The Engine EnvDef default is a blank field. Most RateManager installations do not require an
entry in this field. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located.

Click Save to save your entries. After you have saved your settings, a new tab will be displayed,
Content. This tab will not be needed for a new installation.

No further entries are required at this time. If you want to make additional entries you can.
Additional environments can be added at any time.

If you are running a Windows only environment you can set up your SoftRater databases at this
time. Follow the same procedure of restoring the database, then entering in IBFA.

Optional Setting: Threads

If you know the number of Web Rate Threads you need, you can enter this information now. If you do not
know, you can enter this information later. For more information on threads, please see the IBFA User

Guide.

WARNING: Before changing the number of threads, you should consult with your system

administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Insbridge recommends a maximum of 2 threads.

There are three thread settings in the Insbridge system:

Batch Packing Thread: Found on the Preferences screen of RateManager. This setting is the
maximum number of threads to be used for RateManager Batch Packaging. Batch packaging is
building of packages inside RateManager. This thread setting will not affect rating or any other
process in IBFA.

IBFA Web Threads: Found on the SoftRater Engine page in IBFA. This setting is the maximum
number of threads to be used for rating that is sent through the SoftRater web services. If you
want responses to be returned in the order submitted, this thread setting must be higher than the
maximum number of rate requests contained within a single XML request.

IBFA Message Services Threads: Found on the Message Services page in IBFA. Individual
thread usage can be set for Batch Rating, Batch Scenario and SoftRater-Package.
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STEP 8. VERIFYING THE COMPONENT SERVICES

Next, you should verify the component services.
1. Click Start>Administrative Tools2>Component Services.

2. Expand the Component Services option under console Root.

w

Expand Computers>My Computer->COM+ Applications.

B

Expand each Insbridge COM+ library to make sure there are components listed underneath
each compartment.

Component Services !El E I
“. Fle Action Wiew Window  Help |_|ﬁ'|5|

= = T Il
&= | | XE o [Him| L.
(L1 Console Root ﬁ ? | Actions
[E 2« Component Services - COM-+ Applications o
COM+ QC ZOM+ Ukilities ]
=] (& My Computer Explarer! Dead Let. .. Maore Actions »

B [ Computers
= [ ] COM+ Applications

‘g’ COM+ Explorer ? _% _%
£ COM4 QU Dead Letter Queue Listener :

== COM+ Ltilities COM+ Utilities  Insbridge Insbridge
ey ilitje i (32 hit) Com+ Ad... Cort ...

nsbridge Com+ Administrator 4.5

nsbridge Com+ SoftRater Engine _% /@
L

nsbridge Com+ SoftRater Library

®
&g

F
I

Insbridge System
- Cam+ ... Application
“| DCOM Canfig i
| Running Processes
| Distributed Transaction Coordinator

@ Event Yiewer {Local)
5 Services {Local)

Figure 38 Component Services

There should be 3 Insbridge Com+ Applications libraries:

e Insbridge Com+ Administrator 4.5
¢ Insbridge Com+ SoftRater Engine
e Insbridge Com+ SoftRater Library

NOTE: If any COM+ library is missing, run the Insbridge install again from the msi file and choose
uninstall. Then rerun the IBFA install. Uncheck the RateManager Install. Then check again to see
if all the libraries are listed. If they are still not listed, please log a Service Request with Support.
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Verify the Identity of the Com+ Applications Libraries

Please note that you should not have to make any changes to any COM+ Application library. The
installation will automatically apply the Insbridge user name and password that you created earlier to the

necessary libraries.
1. Select the Insbridge Com+ Administrator 4.5.
2. Right click and select Properties.

3. Select the Identity tab.

4. Verify that the User is Insbridge. If the user is System Account or is not set to the Insbridge user,

change to the Insbridge user set up earlier.

Insbridge Com+ SoftRater Engine Properties EH
Advanced I Dumnp I Foaling & Recycling
General I Security [dentity | Achivation | Gueuing

Thiz applcation will run under the following account,

—Account
™ Sustem Acoount;

{ |nteractive uzer - The curent logged o wuser

) Local Service - Builtin service account,

Hietwork Service - Built-in service aceount with network
ACCEEE

" LocallSystem - Complete aczess o local machine

User: IInshridge Browsze... |

Pazzword: I---------------

LConfirm pazsward: I---------------

'0' Server applications cannot rin under zpstem service accounts.
L 1

Learn more about getting these properties,

k. I Cancel Apply

Figure 39 Updating Com Plus to the Insbridge User

5. Repeat for the other com+ services.
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STEP 9. INSTALLING THE OBI| PUBLISHER

OBI Publisher is necessary for reports. If you do not plan on using reports in RateManager or IBFA, you
do not need to install this program.

1. Unzip the OBI_PUBLISHER

# OBI Publisher Setup BB
0BI Publizher —
Felease MNaotes, (*‘7

his Cracle BI Publisher (Cracle Insurance - Insbridge Install) will update the current
release to 10.1,3.4.0

Install l [ Cancel

Figure 40 Installing OBI Publisher

2. Click Install. A progress screen will be displayed.

3. When complete, click Close.

4. In order for OBI Publisher to be available to users, you must start the Insbridge Message
Service. The Insbridge Message Service can be started from IBFA or from Server Manager in
Windows 2008.

NOTE: The location and port for OBI Publisher is http://localhost:9704/xmlpserver/. This information may
be needed if you have to make a request to your company’s infrastructure and request the
security team to open the ports used by Publisher.
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OBI Security

The OBI Publisher requires a default User ID and password to be entered in IBFA. OBl is required to
create certain reports in RateManager. Users will receive error messages if the OBI Publisher Credentials

are not completed.

Figure 41 OBI Publisher Credentials

%
E-E3 Insbridge Configuration File [C:\PROGRAM
L—_l SoftRate FILES\ORACLE\IGBU\INSBRIDGE \Webs\IBFA\Systems\SoftRater\Xml\ rnxooml
I‘J ortRater Please enter the SoftRater Explorer configuration information below.
4 Engine
|
[ SoftData Admin Email Address:
|| Services
-4 Logs
B Security
-8 Softlibraries Internet Proxy:
&) Help UserlD Password
Intranet Credentials: (®) Use Anonymous
() Domain UserID Password
OBI Publisher Credentials: UserID Password
Save

1. On the left side menu, select SoftRater-> Explorer.

2. Locate the OBI Publisher Credentials.

3. Enter the default user name and password.

User ID: Administrator
Password: Administrator

4. Click Save to save your entry. You must click Save prior to exiting the page.
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Updating OBI Publisher Password

You can immediately update the OBI Publisher password if you want. The password must be updated in
OBI Publisher and then in IBFA.

1. Enter the OBI Publisher console. http://localhost:9704/xmlpserver where localhost is the machine
where IBFA/RM is installed.

2. Select the Admin tab.
3. Under Security Center, select Users.

4. Select the administrator Username.

TOIRACLE' Bl Publisher Enterprise

Welcome, administrator Preferences Sign Out Help

Reports | Schedules | Admin

[ Admin > Users > Update User: administrator |

Update User: inistrator

Cancel I Apply

Username administrator

Figure 42 Updating the OBI Publisher Password

5. Enterin a new password and click Apply. This updates the Administrators password.
6. Sign out of OBI Publisher.
7. Enter IBFA.

8. Open the SoftRater Explorer Configuration window. Enter the same password in the OBI
Publisher Credentials.

9. Click Save. The password has been updated.

NOTE: A login screen is displayed on IBFA for new installs. An upgrade will not reset the current security
setting. For example, if a login was not required for IBFA, upgrading to release 04.09.xx will not
change that. Please see the Insbridge Upgrade Guide for more information.
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STEP 10: STARTING INSBRIDGE SERVICES

It is also recommended that you start the Insbridge Task Manager as well. The Insbridge Task Manager is
a task queue that lists the tasks that are scheduled to be performed as well as the last time the task was
run and the status.

Insbridge Message Service

The Insbridge Message Service is @ Message Queue Listener that will route all batched messages to an assembly (process)
for execution, These processes may take resources and time to execute, Please consult with you system admin before
configuring the number of listeners per process.

| Batch Rating W | | View Messages | | Edit Process Configuration |

If vou =ee this mes=age, yvou have not requested a listing from the selected spoke client. Clicking
Wiew Messages will provide yvou with a list view of the first in - first out messages that are waiting to
execute.

Insbridge Task Manager

The Insbridge Task Manager gives you the ability to execute daily, weekly, hourly, or by the minute,

(This process may take a while to execute)

TASK LAST RUN-DATE START-TIME STATUS

Figure 43 Insbridge Services Screen

1. InIBFA, navigate to the Services page.

2. Next to Insbridge Message Service, click Start. After a few seconds, the buttons will refresh to
indicate that the service is started.

3. Next to Insbridge Task Manager, click Start. After a few seconds, the buttons will refresh to
indicate that the service is started.
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STEP 11: PERFORMING UPDATES IN RATEMANAGER

There are two updates that should be done in RateManager prior to creating user groups and users:
e Step 1. Running Database Updates

e Step 2. Updating Preferences

Entering RateManager:

The URL for RateManager will be http:/SERVERNAME/RM. Where the SERVERNAME is the server
where RateManager was installed.

This places you on the RateManager login screen.

1. To login for the first time, select your company from the drop down menu. If you have created
only one company, a drop down menu will not be presented.

2. The user name is demo.
3. The password is password.
After running database updates, it is recommended that you update the demo user password.

Users and User Groups can be created after any database updates are run. For more on user
management, please see the RateManager Tools User Guide.

NOTE: If you are having difficulties logging into RateManager, please check the error logs in IBFA.
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Step 1. Running Database Updates

If you log into RateManager and Tools is the only option, you must perform a database update. After you
perform the database updates, to view all menu options, click File>Reload.

(& Oracle Insurance Insbridge RateManager 04.08 (10.100.10.10}- .

ORACLE' Insurance Insbridge RateManager

File  Tools Help

Home = @

| pBupdate =

° Please run the update scripts on the database.

Figure 44 Tool Mandatory Update

NOTE: If you log into RateManager and Tools is the only option, you must perform a database update.

On the DB Updates screen, the current version will be highlighted and the status will be Current. The
updates below the current version will be grayed out. These updates cannot be run again. Current
updates can be re-run if necessary. You will receive an error message if you attempt to run a lower
version update. Any version update above the current version will also be grayed out but will be available
for executing.

New installations may show 04.09.00 as current but still have only the Tools option available. You may

have to run the current script again. To see if you have complete access, click File->Reload to refresh the
system.

Navigate to the Tools—>Database—>Updates.

1. The Updates tab is displayed. Select the database you want to view from the Show updates for
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drop down. The database updates for your selection is listed. The last column, the Status
column, shows you which update is the Current one installed.

Home (fj DB Updates X

(@ DB Updates
Q Execute Update Script J;E Open Update Script El Save Update Script to File E’[ﬂ Refresh

I Show updates ﬁ::r:l]BF‘.H R I

Senipt Release Date Database Status
wO4.,09.00.00 11/1/2014 IBR.M
wO4.08.00.00 4/1/2014 IBR.M
wiO4.07.00.00 3/1/2013 IBR.M
w4, 06.00.00 3f1/2012 IBR.M
04.05.01.00 11/1/2011 IBR.M
04.01.00.00 11/15/2010 IBR.M
viO4,00.0.00 3/10/2010 IBR.M
v03.13.0.00 1271572009 IBR.M
vi3.12.0.00 4/320/2009 IBR.M
v03.11.0.00 11/30/2008 IBR.M
vi13.10.0.00 8/21/2008 IBR.M
vwi13.9.0.00 3/19/2008 IBR.M
vi03.8.0.00 &7/ 2007 IBR.M
vwi03.7.0.00 7/28/2006 IBR.M

Figure 45 Available Updates

2. There are two ways to execute an update:
a. Directly in RateManager

b. In SQL Server

Directly in RateManager

This is recommended way to update a database. It is recommended that you start by selecting the update
showing Current. This assures that the database showing as Current will have all possible updates.

1. Highlight the update you want to run.
2. Click EXECUTE UPDATE SCRIPT. A warning message is displayed.
3. Click OK to run the update or Cancel to return to the previous screen.

4. Run all script in consecutive order until the 04.09.00 script is showing as current.
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5. Do this for both the IBRM database and the IB_CLIENT database.

6. Click File>Reload to refresh the system.

& | Confirm Update -- Webpage Dialog Iﬁ

™ Are you sure you want to replace the
y current database's contents with the
selected release script on disk?

3 Ok | & cancel |

e

Figure 46 Updating Scripts in RateManager

In SQL Server

This method should be performed by a database administrator. No warning message will be displayed if
you execute scripts in the wrong order. You must know the name of the databases you are updating.
Database names can be found in IBFA->environments. Please see Manual Updates to the Insbridge
Database.
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Step 2: Updating Preferences

Administrators can edit system settings at any time from the Preferences option in RateManager.
Changes take place after the user sessions have been ended. If web settings are changed while the
users are inside the module, the changes will not be visible to them. Prior to users accessing
RateManager for the first time, it is recommended that Preferences be set.

NOTE: If you receive an error regarding MCSiMenucCtl, please verify that you are using Internet Explorer
8.0 or 9.0 (32-bit). Release 04.09.xx does not support Internet Explorer 8.0 or 9.0 (64-bit).

Changing System Settings

1. Select Tools>Preferences. This opens the Preferences window.

2. Select System. This option is displayed only if you are an administrator.

)
Preferences
--Settings

— User .

| L Home Page System Settings

= Administrator

System Insbridge Configuration File Path: |C:‘.PRDGRAI‘-1 FILES"'.,DRACLE‘.,]I"JSBRJDGE‘.,FRAME‘.'\IORK"A.S.O‘.']rI
-.-igrate Workfiles| Messsging Server: [locahost | secure Chanrep [
SoftRater Server : |.NET| > [localhost | (Secure channel} []
Work Files Share Folder Location: | |
DB Backup Share Folder Location: | |
Use Insbridge Com+ Admin: ITrue “
Enforce Release Packaging: IFalse '
Batch Package Threads:
Minimum Login User 1D Length:
User must change password: (Days)
Show Orverride Date Mask: m
Allow Data Type Change: m
Inactive Session Time Cut: IEI (hrs)
Batch Results with NMewLine: I@
Cnline Help Server: |ID:thDEt |
My Recent List:
= o Default Prowy Script Location: |hﬂp:,-‘,-’v.'pad,-rv.'pad.dai |
¥ Save | 3 Cclose |
h

Figure 47 Preferences Settings

3. Make any necessary changes.

4. When you are finished, click Save to update your settings. If you want to changes to take place
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immediately, you may have to end all user sessions.

System Setting Options
Insbridge Configuration File Path

The path of the configuration file found in IBFA. This pathway must match the IBFA path. You may need
to change this path if you have changed the path in IBFA. Please contact Insbridge support for further
information.

It is strongly recommended that you leave the default.

Messaging Server

RateManager is set up to run batches on the same server that RateManager is located on. If you have an
especially large batch to run and you want to batch to a different server, you will have to change server
locations here. Unless necessary, it is strongly recommended that you leave the default.

SoftRater Server

If you need to rate on another server, you will have to change server locations here. It is strongly
recommended that you leave the default.

Work Files Share Folder Location

A shared Workfiles location allows for multiple instances of RateManager to share the same Workfiles.
The Insbridge server and the shared location must be on the same domain. The Insbridge user must be
on the domain also.

For instructions on setting up a WorkFiles Share Location, please see the Insbridge WorkFiles Installation
Guide on the http://www.oracle.com/technetwork/documentation/insurance-097481.html

DB Backup Share Folder Location

When you make backups of the RateManager database, you can specify the location of the backup file. If
the location is local, use a local path. If the location is not local, you must be a disk admin to change.

If the database is on a remote server, a share is needed for the backup location. The Insbridge user must
have write access to this location as well.

Use Insbridge Com + Admin

This setting must always be true. If there is a conflict, please contact Oracle Insurance support.
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Enforce Release Packaging

When set to False, a release is not required in order for users to create a SoftRater (full) package. False
is the default setting.

If set to True, a release is required in order for a SoftRater (full) package to be created. If a user wants to
create a SoftRater (full) package in the Program Explorer module, a release must be created in the
Releases area first. This release must have the program added to it and be unlocked. When the user
creates the SoftRater package in Program Explorer, they will have the option to select the Release they
want this package to be placed into. If there is no release, or no release that contains that program and is
unlocked, then the user will be able to do RateManager (local) packages only.

Batch Package Threads

RateManager allows you to change how many threads are used. Threading enables a process to finish
faster by splitting the process into smaller processes that run quasi-simultaneously. On multiprocessor
systems, using multiple threads enables the operating system to assign the threads to different
processors.

In addition, the Framework Administrator also enables you to change the administrator email address for
each client. When a process fails, an email will be sent to the person who initiated the process, as well as
to the administrator email addresses listed for the client of that process.

NOTE: Before changing the number of threads, you should consult with your system
administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Oracle Insurance recommends a maximum of 2 threads.

Minimum Login User ID Length

This is the minimum number of characters required for a user ID.

User must change password

This where you set the number of days before a user is required to change his/her password. This setting
will only be active when you elect to have users change their password on the user setup screen.

Show Override Date Mask

If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not enabled, this
field will not be visible.

Allow Data Type Change

The type of data associated with a parameter. RateManager supports three (decimal, integer and string)
data types for variables and inputs and a fourth (date) for inputs and result variables only.
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Setting this option to True allows RateManager users change the data type of a variable or input. Setting
this option to False does not allow users to change data types.

Inactive Session Time Out

This is the amount of time that a user sits inactive before being automatically logged out of the system.

Batch Results with New Line

Allows batch results to go to a new line instead of forming one continuous string. A True setting places a
carriage return between result files. A False setting results in one continuous string without a break.

Online Help Server

Online help is installed with RateManager. This setting is the default server name where RateManager
currently resides. Either a server name or an IP address can be entered here. If needed, you can change
the name of the server. For example, if the machine name is not the same as the host name, you may
need to change the name in order for online help to function.

My Recent List

My Recent List is a snap setting. Snaps are modules that contain information or links to elements that the
user recently worked on. You can set the maximum number of elements to display in a snap. The default
is for the snap list to be limited to 10.

Default Proxy Script Location

The Default Proxy Script Location setting may be needed if you elect to use the Oracle Insurance Blog
Feed snap. This setting can be used for RSS feeds.

Change Control

If change control is on, it is mandatory for users to enter a change control entry and justification to any
element or program when it is revisioned. If change control is off, the option is not presented.

Maximum Amount of Simultaneously Opened Tabs

Use the maximum amount of simultaneously opened tabs setting to set the maximum number of tabs you
allow users to have opened in RateManager. The default is 15.

Debug Report Format
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Select the debug report format to be used in the Test Program section of RateManager. Debug reports
can be a single report format, where the entire report is listed out or in a summary report format where
information is contained in sections that can be expanded and collapsed. Summary report format may be
useful if large programs are to be run. This setting can be updated at a later time.

Default Naming Standard

Select the Naming Standard to be applied system. If a Naming Standard is not needed system wide, clear
the field. The default is for the system default to be used. Please see Naming Standards for more
information.

Enable Worksheet for Test Case Editor

Select true to have the option to create a rating or calculations worksheets in Test Case Editor. Select
false and the option to create a worksheet in Test Case Editor is not presented. Please see Worksheets
for more information.
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STEP 12: EXPORT INSBRIDGE REGISTRY KEY FOR BACKUP

The Insbridge registry key located in HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs). This registry key should be
exported to a text file and stored in a safe location off the server.
This is a safety precaution and will not affect users currently accessing the Insbridge system.
If you have to move RM/IBFA to a new machine or in the event of a catastrophic server failure, where the
RM/IBFA server is non-recoverable, the Insbridge system will need to be reinstalled. When RM/IBFA is
re-installed on a new server, a new registry key will be created. The new registry key will not match the
registry key associated with any packages that have been created. In order to load packages to the new
server, you will need to restore the previous registry key.
You may also be requested to send to your registry key to support.

1. Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.

2. Right click and select Export.

3. Select a storage location for the file and Save.

4. Close out of Registry Editor.

At the completion of this step, you may enter RateManager and begin working.

Suggested Next Steps

When the Insbridge system is ready for users, you can begin to create lines of business and create users.
End users will need to perform setup on their computers in order view and properly work in RateManager.
There is an |E folder in the installation download. In the folder are the executable and the setup guide that
users will need.

- |E7_IE8 Users
¢ Insbridge RateManager Setup Document PDF
¢ RateManager_|E7_|E8.exe

After user logins have been created, it is suggested that the contents of the IE folder be sent to users
along with their login information.

Oracle Insurance Insbridge Enterprise Rating Installation Guide Page 74



Chapter 4

MANUAL UPDATES TO THE INSBRIDGE DATABASES

The preferred method of updating the IBRM and IB_CLIENT databases is to go into
RateManager and run the updates there. If the administrator has DB User privileges and is the
DB Owner of the database as well as the disk administrator, database updates can be done on
the Tools>Database>Updates tab. If these privileges are not in place, an error message will
be displayed. See Step 1: Running Database Updates for instructions.

NOTE: If you need to go from an older version, such as 03.13, it is strongly recommended that
you enter RateManager and run the script successively starting with 04.00, 04.01, and so
on until you reach the 04.09 script. Failure to run scripts in order may result in errors.

To manually update a SQL Server database, you will be required to save off each update and run
them in sequential order in SQL Server. A DBA or a person with the proper permissions will need
to apply the database updates in SQL Server using Query Analyzer.

1. Download the update scripts from RateManager.

2. In RateManager, highlight the update you need. Begin with the version that is listed as
“current”. If you are going from a much lower version of RateManager, you will have to
save multiple files.

3. Click Save Update Script to File. Your computers dialog box is displayed. Save the file
to a location of your choice. For IBRM scripts, it is recommended that you rename the file
to usp_IBRM_R(version number).sql. For example the Release 04.09.00 update would
be: usp_IBRM_R04.09.00.sql. For IB_CLIENT scripts, it is recommended that you
rename the file to usp_IB_CLIENT_RO(version number).sgl. For example the Release
04.09.00 update would be: usp_IB_CLIENT_R04.09.00.sq|.

4. Verify that you have saved all the necessary scripts from “current” to release 04.09.00.
You must save off update scripts for both the IBRM and the IB_CLIENT databases.

5. Next, enter SQL Server.

NOTE: If you do not have database permissions, you will not be able to perform the following
database queries.

NOTE: When using Database Engine Query, the SQL scripts must run on each individual
database.

6. Begin with the current version of either the IBRM database or the IB_CLIENT database.
Open Query Analyzer.

7. Open up the DB script updates from the download file. You can open in any program

you want, such as Notepad. Begin with the “current” script. For example, if you are going
from R03.13 to 04.09.00, 3.13 should be “current”. Open 3.13 first.
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R Microsoft SQL Server Management Studio
File | Edit  View Tools Window Community  Help
F¢  Connect Object Explarer... B ¥ et a SJ = L; ‘Ll)f il g5
| 2 bisconnect Object Explorer \ Object Explorer Details | - X
[ hew v]i3 erojet... CirbeShift+
Gpen Y|l Query with Current Connection  Chrl-+h
Ciose ‘L\u Datahase Engine Query _MARY
isfy  Analysis Services MO Query \IE_CLIENT_MARY 8 Itemis)
&J Analysis Services DMX Query
fiy Analysis Services BMLA Query |
" Save Al Clrle-shif+S \5 SQL Server Compact Edition Query
Source Control » [ views
LA Synanyms
e "
o [ Programmability
[ Service Broker
Exit A Storage
[ 18RM_310_TEMPLATE [ S=curity

Figure 48 Updating Database

8. Select the database you want to update. In SQL Server Management Studio, create a
new Database Engine Query, File>New—>Database Engine Query.

9. Copy the first update from Notepad and paste onto the query screen.

10. Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. You must run the updates in sequential order. Run each update
until you run the 04.09.00 update.

11. When you have finished updating one database, update the remaining database. Make
sure you do both the IBRM and IB_CLIENT databases.

12. After the scripts have been run, return to RateManager. Click Refresh Listing. The
status should show current and the full RateManager menu should be displayed. The
updates are now properly applied and users can log back in to the system.

NOTE: You can view the update script in RateManager. Select the update you want to view.
Click Open Update Script. The update script will be displayed in a separate screen.

F |
2 1BRU : v04.09.00.00 -- Webpage Dislog [
acluse
——5ET THE DATE FORMAT TC AN EXPECTED FORMAT TO SETUP THE SCHEMA INPUTS
SET DATEFOBMAT mdy A
GO
SET IDENTITY INSERT TYPES ITEMS CN
if not exists (SELECT TCOF 1 'X' FROM TYPES ITEMS WHERE VAR DESCRIPTICHN='Message
Tenplate')
INSERT INTO TYPES ITEMS(ID, VAR DESCRIFTION, INTERNAL ONLY) VALUES
(20, 'Message Template', 0)
GO W

Figure 49 Script Viewer
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Appendix A

CREATING AN APPLICATION POOL

If the Insbridge application pool needs to be created, you can create one. The Insbridge
installation must be complete prior to creating an application pool. Make sure that Static Content
is enabled in the Server Manager Roles.

There are three steps to creating an Insbridge application pool and then assigning the virtual
directories.

e Step 1: Create or Verify an Insbridge Application Pool.
e Step 2: Verify settings.

e Step 3: Associate the Insbridge application pool with virtual directories IBFA, insbridge,
RM

1. Click Start > Administrative Tools - select IIS Manager.

2. Expand the Local Computer and select Application Pools. Right click and select Add
Application Pool.

™E Internet Information Services (T15) Manager [_[O]x]
@ 'S [,;-‘ » SERVER » Application Pools |- @ -

File  Wiew Help

Q- i |2 18 GJ! Application Pools

_; Add Application Poal...

-4 Start Page

Set Application Pool Defaults. ..
563 SERVER This page lets you view and manage the list of application pools on the server. Application pools are associsted with worker em
£ o ntain one o more applications, and provide isolation among different applications. (7] Help
L |-=_, Add Application Poal... ‘ = -
| Sites —_— ) = (G0 - \g5how All | Group by No Grouping - Online Help
W3 Refresh [Status | .NET Frame... | Managed Pipeli... | Identit [ applications |
,;?ASP‘NET w40 Started w40 Integrated ApplicationPoollden... 0
QASP‘NET w40 Classic Started w40 Classic ApplicationPoollden... 0
,g_:?CIass\c \MET AppPool Started w20 lassic ApplicationPoollden... 0
) DefaultAppPal Started 2.0 Integrated applicationPoollden... 2

Ready

&

Figure 50 Navigating to Application Pool
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3. Enter “Insbridge” for the Application pool Name. Select the v4.0 for the .NET Framework
version. Click OK. You will be returned to the IIS screen. Your new application pool is listed.

Add Application Pool E I

Marme:
IInsI:uriu:Ige

[MET Eramework version;

MET Framewark, w4,

Managed pipeline mode:
IIntegrated j

v Start application poal immediakely:
Ok I Cancel

Figure 51 Creating a New Application Pool
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Step 2: Update Settings

1. Right click the Insbridge Application Pool you created and select Advanced Settings.

Advanced Settings H

y -
i JMET Framework, Version y4.0
Enable 32-Bit Applications False
Managed Pipeline Mode Inkeqrated
Marme IMNSERIDGE
Queus Length 1000
Skart Automatically True
E CrPu
Lirnit 1]
Limit: Action Modckion
Limit Inkerval (minutes) 5
Processar Affinity Enabled False —
Processar AFFinity Mask:, 4794957295
E Process Model
Identity Insbridge
Idle Time-out {minutes) 1]
Load User Profile False
PMaxirmum YWorker Processes 1
Pirng Enabled True
PFing Maximum Response Time (seconc 90
Ping Period (seconds) 30
Shukdawn Tirme Limik (seconds) a0
Skartun Time Limik fosrnndst an hd
Mame
[mame] The application pool name is the unique identifier For the application poal.

Ik

Cancel |

4

Figure 52 Selecting Application Pool Properties

2. Verify that the .NET Framework Version is v4.0.

3. Verify the identity is Insbridge. If the identity is not Insbridge, you can update it. For the
Identity choose to use custom account and enter the same user that was used to install
Insbridge.

4. Click OK to save your changes.
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Step 3: Associate the web applications with the Insbridge Application Pool

Next, you will need verify or associate the Insbridge web applications with the new Insbridge
application pool.

1. Stay in lIS Manager. Under Local Server = Sites = select IBFA, right click and select
Manage Application-> Advanced Settings.

*E Internet Information Services (115) Manager [_ O]
@ L= 3 b SERVER P Sites » Defaulk WebSike » IBFA I i il |,@, -
Eile Yiew Help
_ &) [IBFA Home [
ﬁ.' o | |"_ |§, U] /I 2 Explore
-5 start Page = Edit Permissions. ..
& & senven Fiter: < [0 - Ghshowal |Goupby: area - EE- —
+ ) Application Paals ASP.NET A 5] Basic Settings...
E-lal %‘35 s . @ . Yiew Virtual Dirertories
13 Default Web Site = > - “i
> = ] — P
“ aspret_client % NF E o3 =W = ab Manage Application -~
S E MET (MET Error {NET MET Profle  MET Trust  Application  Conmection i o —
| Explore ampilation Pages Globalization Levels Settings Strings O
*
Edit Permissions... Brones 'SD,(,h,FFE“L,
— EE=S % a}l_. Advanced Settings. ..
Add application. .. Bl = m————
d  Session Stat SMTP E-mail (7]
© Add virtual Directory. .. Cag:r:;: ession State mal @ Help
Online Help
‘ Manage Application 3 ‘ Browse
k3  Refresh Adwanced Settings... | .
Remove =) = =l =S
(2 Switch to Content Yiew thorization  Compressian Default Directory Etror Pages Falled Request  Handler
Rules Dacument Erowsing Tracing Rules  Mappings
L E=h . ﬂ= =% ook e ="
y & o B 7 4 e =
CH = 7 & =
HTTP Redirect HTTP IP Address Lagging MIME Types Maodules Output Request
Respa... and Dom... Caching Filtering
S50 Settings e
Management
— aa [
E]Features Wiew || - Content View
Ready €

Figure 53 Associating the Virtual Directories with the Insbridge Application Pool

2. Under the General Settings = Application Pool, click the Application Pool entry field to see
the ellipsis (...) button.
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Advanced Settings E

B {General)
Application Pool DefaultAppPool
Phesical Path C:"PROGRAM FILES, ORACLEYINSEBRID
Phesical Path Credentials
Pheysical Path Credentials Logon Type  ClearText

Wirtual Path ITBF A
E Behavior
Enabled Protocaols http

select Application Pool Ed |

application pool:
IMSERIDGE

Properties:

Met Framework Yersion: 4.0
Pipeline mode: Integrated

(0] 4 I Cancel

Application Pool
[applicationPoal] Configures this application ko run in the specified application poal,

Ik Cancel |

4

Figure 54 Adding Application to Application Pool

3. Click the ellipsis button. A separate window is displayed.

4. Select the Inshridge Application Pool.

5. Click OK. Click OK again to close the Advanced Settings window.

6. Repeat for RM, and Insbridge.

7. Return to the Insbridge application pool. Right click and select to view the applications.
8. Right click to View Applications. The three Insbridge applications should be listed.

9. Select the server level above the application pools and restart IIS. On the IS screen,
Actions>Restart IIS.
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" Internet Information Services (115) Manager [_ O]

@,,.,) [ v server »

File Wiew Help

| & @ -
addons

&9 SERVER Home
v Manage Server
Filker: - (o - (show al |Groupby: Area - El- _ * Restart
b Start
ASP.NET -
L@l Sikes P ~ [ ] e
) Default web Site EE%' N> (¥ ?’, = ;ﬁ? View Application Pools
L = L#
JMET JMET WMNET Error JMET JMET Trusk Application Connection  Machine Key ek ok
Authorizati,..  Compilation Pages Globalization Levels Settings Strings Change HET Frameia il
E R & [
s e = Orline Help
Pages and Praviders  Session State  SMTP E-mail
Contraols
s
2 £ : ) Y 5 e
B B[ d e & &
Authentication Authorization  Compression Default Directory Error Pages Failed Request  Handler
Rules Document Browsing Tracing Rules Mappings
& v B @6 @ i
. - . ) = o o=l
de S & = it; &
HTTP Redirect HTTP IP Address  ISAPLand CGL ISAPI Filters Logging MIME Types Modules
Respo... and Dom. .. Restrickions
£ & <
) o= # &y
Qutput Request Server Warker p—
Caching Filtering Certificates Processes
Management
= E ] Fay - [ — LI
E] Features Wiew || Content View
Ready €

Figure 55 Restarting IS

Application Pool Error

If you choose not to create an Insbridge Application Pool, the Insbridge application will use the
default application pool. If you receive an error when accessing IBFA for the first time after a new
install:

CS0016: Could not write to output file
‘c:\Windows\Microsoft. NET\Framework64\v2.0.50727\Temporary ASP.NET
Files\ibfa\783d6267\bccaOb3e\App_global.asax.zf-kqiii.dIl': 'Access is denied. "

You may have to create a separate Insbridge Application Pool.
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Support

CONTACTING SUPPORT

If you need assistance with an Oracle Insurance Insbridge Enterprise Rating System product,
please log a Service Request using My Oracle Support at https://support.oracle.com/.

Oracle customers have access to electronic support through My Oracle Support. For information,
visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Address any additional inquiries to:

Oracle Corporation

World Headquarters

500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200

oracle.com
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